Guide for Downloadin%and Initial Processing of High Resolution Topographic data for short course
“LIDAR Derived DEMs applied to Landslide, Fault, Earthquake Rupture, and Landscape
Changes” (Modelos Digitales de Elevacién de LIDAR Aplicados a Deslizamientos de Tierra, Fallas,
Ruptura por Sismos y Cambios del Paisaje)

http://www.opentopography.org/index.php/resources/short courses/15 UNAM

Written by Alana Williams, Emily Kleber, and Ramdn Arrowsmith (ASU/OpenTopography)

This guide explains how to download high resolution topographic data of México from INEGI
(Instituto Nacional de Estadistica y Geografia). The goal is to download the data and prepare it
for working in ArcGIS for analysis.

There are two types of gridded data available (this is not the LAS format point clouds):

Superficie (surface or highest hit)- Terreno (bare earth)
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Superficie (surface or highest hit)- Terreno (bare earth)
[These data are from INEGI: E14B31D3 & E14B31D4; 5 meters per pixel digital elevation models
(Modelo digital de elevacion de alta resolucién Lidar) from the area of Parque Xicotencatl).

Software needed
® ESRI ArcGIS. We will use ArcCatalog and ArcMap
e Software to extract data from .zip files
o Free options- 7-zip: http://www.7-zip.org/download.html
O WInRAR: http://winrar.en.softonic.com/download
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Flow chart below illustrates import pathways depending on gridded data depending format (.xyz or
binary grid).

Locate study area

Mapa Digital de México @

|

| Download data from INEGI ‘

Format 1: ASCII XYZ Data (filename.xyz) ‘ ‘ Format 2: Arc binary Grid (filename)

i

Change extension to text file
(filename.txt)

l

ArcCatalog: Convert to databse
(filename.dbf)

|

‘ ArcCatalog: add XY data ‘

|

‘ ArcCatalog: Point to Raster ‘

‘ Define Projection |

Vi

‘ Import into ArcMap ‘
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STEP 1- LOCATE DATA FOR DOWNLOAD

Before downloading data, you need to find the data areas you are interested in using INEGI’s Mapa
Digital de Mexico.

Mapa Digital de México o
http://gaia.ineqgi.org.mx/mdm6/

©
Topografico con sombreado- INEGI

There are layers on the right side. Select the layer that will best
show the area you are interested in. We are interested in
topographic data, so the “topografico con sombreado - INEGI” is
the best.
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Zoom to your area of interest.

@ ‘ Energia Solar Edafologia ‘ Uso del Suslo Gedogia ‘

oF 7 ' i
@ Hipsogréfico - INEGI
Select the “Capas” or layer symbol (green, red, yellow layer symbol
below map) to bring up the layers that are available.

Marco cartogrifico

[##] Limites de cartas eceala 1:10 000 TP
|| Limites de cartss escals 1:20 000 TP
[ | Limites de cartas escals 1:50 000 TP
[ Limites de cartss escala 1:250 000 T

Scroll to “Marco cartografia”, select box next to “Limites de cartas escala 1: 10 000” and select the T
symbol. It will be added to the column on the right and added to your map. You can then close the
Capas window.

Capas de informacion

¥ Servicios DENUE
|#| Sarvicios
[ Limites de sartes 2zcals 1010 000 iy
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IFTHE T ISNOT SELECTED, THE DATA INFORMATION WILL NOW SHOW. Make sure that it is turned on.

Depending on your internet browser, it may take a few seconds to show the tile names.

You can also select individual tiles to see what their title is

Buscar Xp
L 4 3 £ O

Resultado Georref.

Informacion del punto: p 4
98° 53'42.28" W, 19° 4" 18.76" N

Limites de Ortofoto escala 1:10 000 E14B41D2 i
Juchitepec, México

Make note of the tiles you are interested in downloading by copying the code from above for the data

you want to download (Example: E14A49F2).
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STEP 2- DOWNLOAD DATA FROM INEGI

Follow this link to download the data:
http://www3.inegi.org.mx/sistemas/productos/ContenidosSD2.aspx?cl=209010000&cs=0&ac=0&N=0&
A=0&Nv=2&titulo=Continental

You will have the option of downloading data in GRID or ASCII format for surface or bare earth DEMs.

Click on the link.
Publicaciones

Consulta
Centros de
Informacion

* Maodelos Digitales de Elevacion (Varias publicaciones) “erdisponibilidad al interior

* Maodelos Digitales de Elevacion de Alta Resolucion LIDAR, Superficie Ascii, con resalucian de
Am (Varias publicaciones)

* Maodelos Digitales de Elevacion de Alta Resolucion LIDAR, Superficie Grid , con resalucién de
Am (Varias publicaciones)

* Maodelos Digitales de Elevacion de Alta Resolucion LIDAR, Terreno Ascii, con resolucian de 5m
(Varias publicaciones)

* Maodelos Digitales de Elevacion de Alta Resolucion LIDAR, Terreno Grid, con resolucion de 5m
(Varias publicaciones)

En linea

“er disponibilidad al interior
“er disponibilidad al interior
“er disponibilidad al interior

Verdisponibilidad al interiar

You will be given an option to search for the data, enter the tile code in the box.
Note: Not all tiles contain all data. Some regions are missing ASCII (filename.xyz), GRID (filename) or
both.

The first page has the metadata about the file. It is important to note the “Proyeccién” and “DATUM”.
We will need this information later. For example, the file below is in Universal Transvera de Mercator, or
UTM, with ITRF92 datum.

Productos

Superficie. GRID. E14B51A3

Ficha Descarga

Entidad Federativa: Marelos

Edicidn: 2012

Desglose geografico: Nacional

Formato: Electranico

Escala: 1:10 000

Clave carta: E14B51A3

Proyeccion: Universal Transversa de Mercator
DATUM: ITRF92

Click on the title of the result you want to download, and switch the tab to “Descarga”. Click on the XYZ
icon to download the data.
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Productos

Superficie. GRID. 111D87B3

Ficha Descarga

Right click on the zip to extract the files you have downloaded.

Downloads » Mexico v ¢ Search Mexico
A Name Date modified Type Size
@ 702825778941 2z J17/2015413PM  ZP i

Open

’ 7-Zip » Open archive
Open with » Extract files...
Share with » l bindiee

Extract to "702825778941 xyz\"

There are two formats of data that are downloaded from INEGI: XYZ data (filename.xyz) or Arc Grid
(filename). They may be different based on your area of interest so please take note.

Take a look at this flow chart to see which process you must follow to access your data.

Locate study area

Mapa Digital de México @

l

| Download data from INEGI |

Format 1: ASCII XYZ Data (filename.xyz) ‘ | Format 2: Arc binary Grid (filename)

Change extension to text file
(filename.txt)

J

ArcCatalog: Convert to databse
(filename.dbf)

[

| ArcCatalog: add XY data ‘

|

| ArcCatalog: Point to Raster ‘

| Define Projection I
I\
‘ Import into ArcMap |
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Format 1, GRID format- Grid is an elevation file data format

; MS_Auxliares
. M5 _Grid
; M5_Metadatos

The folder “MS_Grid” contains a grid file that looks like this in windows explorer. To view the file, you
have to use a piece of GIS software like ArcMap or il ArcCatalog -

, e14d12b2_ms

. hillsha_glddl

, info
Hillsha_el4dl.aux

L] log

File in ArcCatalog,

= 3 702825538439 _xyz_5_be_grid
+ £ MT Auxiliares
= £ MT_Grid
= £ E14012B2_MT
+ HE e14d12b2_mt

Format 2, ArcGrid format- ASCl| is the same as a text file

; MT_Auxiliares
, MT_Metadatos
| MT_XYZ

The folder “MT_XYZ” contains a text file like this one, “E14D12B2_MT.xyz"

5527587.500 1983187.500 1205.520
552802.500 1983187.500 1203.670
552807.500 1983187.500 1201.870
552812.500 1983187.500 1200.000
552817.500 1983187.500 1158.100
552822.500 1983187.500 119&.020
552827.500 1983187.500 1153.730
552832.500 1983187.500 1191.750
552837.500 1983187.500 1185.710
552842.500 1983187.500 1187.480

The 3 columns are x coordinates (UTM Easting), y coordinates (UTM Northing, and z coordinates
(elevation) for lidar points. We will need to convert these data to dbf files to open them up in ArcGIS.

First, open files in Wordpad or other .txt document. You may need to change the file type to “all file
types” if you cannot locate XYZ.
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» ThisPC » Downloads » Mexico » MS_XYZ v & _XYZ L
folder == w L @
2 Name : Date modified Type Size
No items match your search.
v
‘ile name: v All Wordpad Documents (*.rtf, v

Rich Text Format (*.rtf)

Office Open XML Document (*.docx)
OpenDocument Text (*.odt)

Text Documents (*.txt)

Text Documents - MS-DOS Format (*.txt)
Unicode Text Documents (*.txt)

All

YI]U Tuhe https://www.youtube.com/watch?v=sQRM3hD |y8

YouTube video explaining the following process of converting .xyz files to Arc Binary Grid files.

The results should look like the three rows of numbers shown above, with the X value column equally
spaced in 5 meter intervals, and the Y values in O meter intervals. These represent the Easting and
Northing values. So no change in the Northing values means the data was taken in an east-west line and
represents a Digital Elevation Model, and not a random point cloud.

Next, go into your folder, right click on the file and select “rename file” and change the file name to
“axt”.

Marme Date modified Type Size
""" E14B51C2_M5.bdt | 73,2013 1:36 PM *YZ File 57487 KB

You may have to make this file name change at the command line to truly turn it in to a .txt file:

C:\Users\ramon\Desktop\INEGI_data_demo\702825776169_xyz\MT_XYZ>rename x.xyz el4y

31d3_mt. txt
ArcToolbox C:\Users\ramon\Desktop\INEGI_data_demo\702825776169_xyz\MT_XYZ>dir
Uolume in drive C is Windows8_0$S

Bl ArcToolbox Uolume Serial Number is 225D-9CDT

+ % 3D Analyst Tools Directory of C:\Users\ramon\Desktop\INEGI_data_demo\702825776169_xyz\MT_X¥2Z
+ % Analysis Tools

02:00 PH  <DIR>
x % Cartography Tools 02:00 PH  <DIR> .
_ a Conversion Tools 01:22 PH 49,901,096 elub31d3_mt.txt

+ By Excel

+ B From GPS

+ B From KML

+ B From Raster
+ B From WFS

+ B JS0N

+ By Metadata

+ & To CAD

+ By To Collada

+ B To Coverage
- & To dBASE 16

5 Table to dBASE (multiple)

Now open up Arc and use the Toolbox - Conversion Tools < To
dBASE -> Table to dBASE (multiple) to import the file.


https://www.youtube.com/watch?v=sQRM3hD_ly8

Select your .txt file as the “input” and select the same folder for your “output” location. You can place it

in any folder, just remember where you put it.

Input Table
C:\Users\Ramon\Desktop\demo\E 14D 1282_MT. txt [E]
1)
4
Output Folder )
C:\Users\Ramon\Desktop\demo E'."

When this is complete go to File > Add Data - Add XY Data

Output Folder

The destination folder
where the output dBASE
table(s) will be placed.

File | Edit View

Bookmarks Insert Selection

Geoprocessing C

3 New..
£ Open..
& save

1 Save As...
Save A Copy...

CtisN b . |
Ctrl+0
Ctrl+S

| ]| & - @
REEEY

x|

Share As

| AddData

» | & AddData...

A table containing X and Y coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

-1&

B0 EE

|  E14D1282 MT
Speaify the fields for the X, Y and Z coordinates:
X Field: Fedt

Y Field:

Page and Print Setup...

Print Preview...

Add Basemap
Add X Data...
Geoco‘gng

e
RS

Add the DBF file where it asks you to choose a table,
and make sure that the X Field says “Field 17, the Y
Field says “Field 2”, and the Z Field says “Field 3”.

[ show Details
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The result will be evenly spaced points. It will look like a black square, but if you zoom in you will see the
individual data points. You can click on the Info tool and click a dot to

"y -
& @ Convession Tools see it’s specific X, Y, and Z value.

i+ & Excel
w1 & From GPS
w & From KML
@ & From Raster
@ & From WFS
@ & JSON Now you can convert these files to raster by going to Toolbox -
@ & Metadata Conversion Tools = To Raster - Point to Raster.
@ & To CAD
@ & To Collada
& & To Coverage
= & To dBASE

N Table to dBASE (muitiple)
® & To Geodatabase
i & ToKML
= & To Raster

#, ASCIH to Raster

#., DEM to Raster

#, Feature to Raster

“. Float to Raster

#, LAS Dataset to Raster

#, Multipatch to Raster

A

< ol

", Pofigon to Raster

4, Polyline to Raster

In the boxes provided choose the “Event” file for your input, and change the field to you Z values “Field
3”, and change the output to your same folder, and give it the binary name to keep things consistent.
You should leave the Cell Assignment Type and Priority Field as “Most Frequent” and “None”. The Cell
size should be changed to 5 meters.

. Point to Raster

Input Features
[E14D1282_MT Events =l
Value field
Field3
Qutput Raster Dataset
C:\Users\Ramon'\Desktop\demo'\E 14D 1282
Cell assignment type (optional)
MOST_FREQUENT
Priority field (optional)
NONE
Cellsize (optional)
sl
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Finally, go into your Table of Contents and turn off your Points by unchecking the box next to your event

file, and the finished product is your Digital Elevation Model.

oS8 3

= & I_aym
= ﬁ E14D12B2_MT Events
<

Value
High : 1558.96

Low:1082.32

From this point you can continue on to make contour interval
layers and hillshades, etc.

STEP 3: DEFINE PROJECTION

Before loading data into ArcGIS, the coordinate system must be
identified for the file. This is important for placing your map in
the correct area and lining up with any previous mapping done
or GPS points.

You should have found the projection information for your file in
step 2. If not, go back to the INEGI website and locate it. You can
also find it in the MS_Metadatos metadata file.

To define projection you go to ArcToolbox > Data Management

Tools > Projections and transformations > Raster > Define
Projection
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5] ArcToolbox
3 30 Analyst Tools
a Analysis Tools
&3 Cartography Tools
@ Conversion Tools
a Data Interoperability Tools
=] & Data Management Tools
& Attachments
& Data Comparison
& Distributed Geodatabase
% Domains
B Feature Class
& Features
& Fields
& File Geodatabase
& General
& Generalization
& Geodatabase Administration
& Geornetric Network
& Graph
& Indeses
& Joins
B LAS Dataset
& Layers and Table Views
& Package
& Photos
= & Projections and Transformations
& Feature
& Raster
“\ Convert Coordinate Motation
“\ Create Custom Geographic Transformatien
‘t\ Create Spatial Reference
ﬂ% Define Projection



Add the DEM file. Click the symbol to select your coordinate system.

#. Define Projection o|E8] ®
Input Dataset or Feature Class o
LisersUoyBubbles\Desktop| 702825796 198 _xyz\MS_Grid\E 1902282 MS\e 14d22e2_ms ‘—_:;
Coordinate System o
Unkniown &1

1 I oK Cancel Emimmenu Shaw Help >

XY Coordinate System Z Coordinate System

v

Type here to search v/ @R@ v

[l& Favorites

SL/GS 1984 UTM Zone 14N|
[*/& Geographic Coordinate Systems
[*/& Projected Coordinate Systems
& Layers

Current coordinate system:

WGS_1984 UTM_Zone_14N ~
WKID: 32614 Authority: EPSG

Projection: Transverse_Mercator

False_Easting: 500000.0

False_Northing: 0.0

Central_Meridian: -99.0

Scale_Factor: 0.9996

Latitude_Of Origin: 0.0

Linear Unit; Meter (1.0)

You can search for the coordinate system by typing it into the search box. The example from
earlier was in ITRF 1992. However, ArcGIS does not support projected ITRF datums so we
will use WGS84 UTM with appropriate zone.

Click ok to apply to your DEM.

Once you've defined your coordinate system, you are ready to start DEM analysis in ArcMap!
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STEP 4 (OPTIONAL): Project multiple DEM tiles to new raster
Each INEGI DEM tile is ~6 km E-W and ~7 km N-S and we will most certainly have study areas
larger than that or which span tile boundaries (like the volcano of Parque Xicotencatl).

Table Of Contents

ox
EHees g
= & Layers
- ®@el4b31d4_ms
Value
" High: 2446.02

Low:2211.45

[El-1c14b31d3_ms]

Value
¥ High:2393.71

Low: 2223.87

Therefore we should Mosaic them to New Raster:

=

Data Management Tools

& Archiving

& Attachments

& Data Comparison

& Distributed Geodatabase

& Domains

& Feature Class

& Features

e Fields

& File Geodatabase

& General

& Generalization

&y Geodatabase Administration

& Gearnetric Network

& Graph

& Indexes

& Joins

& LAS Dataset

& Layers and Table Views

& Package

& Phatos

& Projections and Transfarmations

&, Raster

[+ & Mosaic Dataset

[4] & Raster Catalog

[=| & Raster Dataset
#, Copy Raster
#, Create Random Raster
#, Create Raster Dataset
#, Download Rasters

#, Mosaic

#, Mosaic Ta Mew Raster

NHFEFEHEFEEFEEHEFFEEE R &
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Input Rasters A
I v
C:\Users\ramon\Desktop\INEGI_data_demo\702825776152_grid\MS_Grid\e14b31d3...
C:\Users\ramon\Desktop\INEGI_data_demo\702825776190_grid\MS_Grid\e14b31d4...

Qutput Location

‘ C:\Users\ramon\Desktop\INEGI_data_demo |

Raster Dataset Name with Extension

| e14b31d \

Spatial Reference for Raster (optional)

| WGS_1984_UTM_Zone_14N \

Pixel Type (optional)

| 32_BIT_FLOAT v/

Cellsize (optional)

Number of Bands

| b

Mosaic Operator {optional)

|LAST v]

Mosaic Colormap Mode (optional)

CFIRST v

v

oK H Cancel H Environments... H Show Help >>

Parque Xicotencatl area projected and mosaicked surface colored DEM semi-transparent over
hillshade.
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